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OVERVIEW 
Summit Central is a customer relationship management (CRM) database with multiple functions. 

A Contact Management System 
Summit Central enables you to track contacts with your clients and prospects and gives reminders of 
appointments, tasks to be done, etc. It tracks details of people’s event attendance history, profiles, 
groups and user-defined fields and can record details of up to three addresses per person. Data can 
be imported from a variety of sources and Summit Central gives real-time duplicate checking during 
the import process.  

Summit Central comes with a powerful Reporter that enables you to select and target specific groups 
of people and produce user-defined lists or address labels. As well as printing reports, any listing or 
report can be sent as an e-mail attachment, exported to Microsoft Word, exported to Microsoft Excel, 
exported to a text file or converted to an HTML page for publishing on the web. It can track specific 
mailouts as well as record bulk contacts that are made using broadcast fax or e-mail. 

You can export name and address details to a variety of formats and produce mail merge documents 
for the selected people. For Summit Event Manager users there is the added ability to send the 
selected contact details to a Summit event file. 

A Master Database 
For Summit Event Manager users, Summit Central enables you to keep a master database of people 
who have attended events, along with details of their participation in each event.  

You can send people on the Summit Central database directly to a Summit event file, without opening 
the event file, either one at a time from the People form or in batches from the Reporter. If you change 
their details in the Event Manager, you can elect to have those changes automatically reflected in 
Summit Central, i.e., even though there is a copy of the data, data integrity is still maintained through 
a seamless interface via the person’s PIN number. 

Within Summit Central you can nominate an event file and it will import the selected people into the 
database together with their event participation details. It will update the cumulative event 
participation history for people already on the Summit Central database.  

You can use Summit Central as a master database in conjunction with other event management 
software packages, but while peoples’ records can be imported, event and participation details need 
to be entered manually. 

An Information Interchange Format 
Summit Central gives you an easy way to share your database information with others. You can send 
your data file to the other person and they can download a free Summit Central Viewer from our 
website. The Viewer will not let them change any information but they will be able to look at the data, 
run off reports and even export the information to a format they know they can use. The Viewer uses 
the ‘Look but Don’t Touch’ feature. 

People to whom you send these databases will be able to use the information free-of-charge, 
instantly, without having to worry about data conversions, what order fields are in or whether or not 
they have the correct software to read the information.  
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Summit Central Components 
The Summit Central core database is the master database and contact management system, 
however you can purchase additional components including Membership Manager, Products & 
Services, Short Courses and Donations, which have additional features as outlined below. 

Membership Manager 
The Membership Manager component of Summit Central allows not only for the recording and 
tracking of a contact database, it enable users to store and manage memberships, organise tasks to 
ensure goals are met and produce and record all correspondence such as welcome letters, 
membership renewal reminders, newsletters, promotional offers, meetings and season greetings and 
birthday cards. 

Through Membership Manager of Summit Central you can define the structure and type of 
memberships, process expressions of interest, process membership joins and renewals and maintain 
all financial requirements and banking.  

Membership Manager has a meetings feature which allows all past, present and upcoming meetings 
to be recorded, including the details of the meeting, meeting attendees, agenda and meeting minutes. 

Products and Services 
Through Summit’s additional Products & Services feature you can record items or services provided 
by your organisation. This function enables the user to enter all items available for sale or rental to 
clients with the relevant pricing, and print listings of all people who have purchased or rented a 
particular product or service. 

Short Courses 
The courses component of Summit Central enables you to create and manage courses/programs in 
addition to the management of your core contact database.  In this function you can manage 
registrations and attendance to short courses, send correspondence via email to attendees, monitor 
income and expenditure, and produce attendance certificates. There is also the option of sending 
SMS Alerts to participants. 

Donations  
Summit Central Donations Manager enables the user to enter and produce reports on donations for a 
particular donation campaign, and to define specific elements within each campaign.  

Internet Assistant  
The Internet Assistant enables the management of forms received via the internet including updating 
of contact details, membership joining and renewing, demographics update, registrations to courses, 
online ordering of products and/or services and donations (the last two still in development). 
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The Summit Suite of Software 
MIE Software also develops the Summit Event Manager; software for the management of 
conferences, seminars, gala dinners and training sessions, or for any occasion where you need to 
bring people together. The picture below shows in graphical form how the two software packages 
integrate. 

 

 

 
 

 

 



Getting Started - 4 

 

GETTING STARTED 
 

Welcome to Summit Central. 
 

This chapter covers the following information essential to successful installation and use of Summit 
Central. 

 

• system requirements 

• conventions used in this manual and in the software 

• changing the screen resolution in a Windows environment 

• Summit Central in a networked environment 

• installing Summit Central 

• installing the Microsoft Access runtime environment for Summit Central 

• registration of your Summit software  

• start-up options for your first time opening Summit Central 

• introduction to the Summit Central forms used in this software 

• navigating in Summit Central - what all the standard buttons are and what they do 

• help - general and specific 

• date formats 

• printing reports in Summit Central 

• shortcut keys - how to perform certain tasks quickly and easily as well as move around without 
using the mouse. 
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System Requirements  

Minimum System 
Pentium 4 – 1.4 Ghz 

Microsoft Windows XP 

100 Mb hard disk space 

1 Gb RAM or higher 

SVGA or higher resolution monitor  

CD Drive 

Recommended System 
Pentium 4 – 2.4 Ghz 

Microsoft Windows XP 

100 Gb hard disk space 

4 Gb RAM 

SVGA or higher resolution monitor 

CD Drive 

WinZip – archive/compression program 

MS Outlook – for individual and broadcast e-mails 

Express ClickYes – assists with individual and broadcast e-mails (provided free) 

MS Access 2003 

Conventions used within this manual 
This user manual has been designed with the following concepts in mind. It is a standard A4 size so 
that most descriptions of forms and reports fit on a page and to allow for easy photocopying. The text 
is in Arial 11 point so that it can be easily read. The following is how the components of Summit are 
described within this manual: 

• Forms, Reports and Menus are in Title Case 

• Data fields and Buttons are in Italics 

• File & folder names and computer commands are in Bold 

User defined words are enclosed in angled brackets, i.e. < >. Every data entry form has on its toolbar 
(form footer) as standard the OK button, the Cancel button and the Help button. For brevity, when 
describing each form, these three buttons are not included. The screens displayed are taken from a 
Windows XP and 2003 environment, and therefore may appear a different colour to those using 
earlier versions of these programs. 

Field 
A field is anywhere you can enter data. Fields can be normal, a combo box, an option box or a check 
box. 
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Combo Box 
The presence of a combo box indicates that there is a reference file behind the field and usually, but 
not always, limits the data entry to one of the list (limit-to-list). To see the list of possible entries, click 
on the down arrow to the right of the field. 

      

 
Option Box 
An option box has a minimum of two options from which you may choose one. If you click in one 
option box, you’ve effectively selected that option to the exclusion of the rest. The selected option is 
black. Option boxes are always round and are on a raised square. 
 

 
 
Check Box 
Check boxes are used to indicate Yes or No. If you want to indicate Yes - you ‘mark’ the check box by 
clicking in it or pressing the space bar. This puts a tick in the square. Clicking in it again ‘unmarks’ it to 
indicate No. Check boxes are always square.  

 

 
 

Combo box 

Selected option

Reference Files 

Marked Check 
Box = Yes 

Unmarked Check 
Box = No 
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Closing Forms 
The forms in Summit Central don’t have the system menu icon on the top left hand side of the title bar 
and must be closed using the command buttons found in each forms toolbar.  

Any of the following command buttons will close the active form. 

 

 Closes a menu or other non data entry form. 

 

  Cancels all changes made to the current record and closes the form. Changes made to 
sub records will not be cancelled when you exit the main menu in this way. 

  Saves all changes made to the current record and closes the form. 
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Entering Dates and Times 
The quickest way to enter a date is ‘day space month’ or ‘day forward-slash month’ and the current 
year is assumed. For example, if you entered ‘9 4’ or ‘9/4’, the system will redisplay ‘9-Apr-03’. Every 
date field has a calendar next to it. See Select Date further on.  

The times in Summit are all 12-hour clock. To quickest way to enter a time is ‘time space a’ for an AM 
time or ‘time space p’ for a PM time. Minutes are indicated by the full stop or the colon. To display 
10am, you would enter ‘10 a’ or ‘10 p’ for 10pm. For 12:45pm, you would enter ‘12.45 p’ or ‘12:45 p’. 
The AM and PM formats are whatever you put in your Time tab of your Regional Settings in your 
Control Panel. 

Select Date Function 
This form enables you to select a date using a graphical calendar at the end of each date field and 
then pass that date back to the field. If there was already a date in the field on the original form, the 
calendar is set to that date. If the field on the original form was empty, the calendar is set to today’s 
date. 

 
The bottom of the Select Date form displays the name of the field you’re working on and the date 
you’ve selected. 

The calendar is set to display Sunday as the first column on the calendar. If you wish to you can 
change this to any day of the week by selecting the day you want from the pull-down list of First 
Column.  

 
 

The calendar displays one month at a time. If the date you want is currently displayed, position the 
mouse on the date you want, then click on the left mouse button to select it. If the month or year you 
want is not displayed, select them from the pull-down lists. 

Click on the OK button to update the field on the original form. Click on the Cancel button to close the 
calendar without updating the field on the original form. 

 

Select Date function 
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Changing the Screen Resolution 
Prior to installing Summit Central it is useful to check your screen resolution. Summit Central forms 
have been designed to fit on a screen resolution of 1024 by 768 pixels – XGA (eXtended Graphics 
Array). If your current screen resolution is less than this (for example, 800 by 600 pixels ), the forms 
won’t fit and you’ll have to use the scroll bars to navigate.  

 

 

 

To check and/or modify your 
screen resolution, take the 
following steps: 

 

 

Right mouse click on the desktop 
to view the desktop menu and click 
properties. 

 

On the Display Properties Screen, 
select the Settings Tab, as shown 
below  

 

Ensure the screen resolution slider 
bar is set at 1024 by 768 or higher. 
If it is set lower than 1024 by 768 
move the slider bar to adjust. 

 

Click Apply to save these changes 
and exit the Display Settings 
screen. 
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Summit Central in a Networked Environment 
In a multi-user environment, Summit Central (SCL) can be loaded on up to ten computers on a local 
area network. Illustrated below are two examples of network set-ups. 

Client Server Network 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Peer to Peer Network 
 

 

 

 

 

 

 

 

 

 

 

 

NOTE: The scl.mdb file should not be loaded on the network as a shared application, but onto the 
local hard drive of each individual PC wishing to access data (.mdb) files - the shared data. Using the 
scl.mdb file as a shared application will create conflicts with multiple users overwriting and clearing 
each other’s work tables. 

File Server 

Holds SCL data (.mmd) files 
but should not be loaded with 
Summit Central Software. 

User 1 

Copy of Summit 
Central 

User 2 

Copy of Summit 
Central 

User 3 

Copy of Summit 
Central 

User 4 

Copy of Summit 
Central 

User 1 

Copy of Summit 
Central 

and the data (.mdb) 

User 2 

Copy of Summit 
Central 

User 3 

Copy of Summit 
Central 

User 4 

Copy of Summit 
Central 
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Installing Summit Central  
 

You can only download Summit Central if you have Microsoft Access 2002, 2003 or 2007 running on 
your computer. If you do not have these installed on your computer you will need to download the 
Microsoft Access 2003 Runtime environment.  

 

If you have Microsoft Access 2007 installed, you should install the Microsoft Access 2003 version. 

  

 

 

From the MIE 
homepage click 
on the  

Download Free 
Software link 
and select 
Summit Central 
from the list of 
options to 
download 

 

 
 

 

 

After Reading 
Steps 1-3, 
double Click on 
the version of 
Summit Central 
required –
choose the 
option to ‘Save’.  
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Click Save to 
begin the 
installation 
process.  

Save the file to 
a place on your 
computer 
where you will 
find it again, 
this should 
usually be in 
your C: drive 
under 
downloads. 

 

 
 

 

 

 

 

 

Summit Central 
will download 
all the relevant 
files. 

 

 

 
 

 

 

 

 

 

Click Run. 
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Click Yes to 
continue with 
the installation. 

 
 

 

 

Select the 
Setup button 
where you will 
be prompted to 
the Setup 
Wizard. 

 

 

 
 

 

 

 

 

 

 

 

 

Click Next 
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Select I Accept 
the terms in the 
Licence 
Agreement and 
then click next 

 
 

 

 

 

 

 

 

Click the 
Standard 
button to 
continue 
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Click Install 

 

 

 
 

 

 

 

 

 

 

 

Click Finish 
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After the wizard 
is complete 
select Finish 
and your 
Summit Central 
Setup is 
complete. 

 A Shortcut will 
automatically 
be placed on 
your desktop 
and in your 
start menu. 
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Software Registration 
When you open Summit Central for the first time you will be prompted to register the software as seen 
below. 
 

 
 

While it is quite legal to use unregistered copies of Summit Central, there are benefits to registering 
your software.  

 

The main benefits of registered software are: 

• With registered software, there is no limit to the number of records that can be entered or 
imported into each database; unregistered software has a maximum of 20 records per 
database. 

• With registered software, you’re entitled to three months of free telephone, fax or e-mail 
support calls. No support is provided for unregistered software. 

• Registered software runs more quickly than unregistered software. 

 

To register your software you need a serial number. This will be supplied by MIE Software upon 
purchase. To register your software click on the Register button of the toolbar in Summit Central.  
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If you have not received a serial number you can request one by clicking the ‘Request New Serial 
Number’ button shown below or you can contact MIE Software. 
 

 

Starting Summit Central 
When you first install Summit, a new submenu is added to the Programs menu. To access Summit 
Central you can either double-click on the icon which is automatically placed on your desktop during 
installation, or you can locate the program through the Start menu list of Programs.  

Startup Options 
The form below will be displayed when you launch Summit Central and it is unable to link to a Summit 
Central database.  

 

 
 

This will happen if this is the first time you have launched Summit Central (and no Summit Central 
databases have been created) or the database to which Summit Central was last linked has been 
moved, renamed or deleted. 

 

Select whether you wish to Create a New Empty Database, Open an Existing Database, Open the 
Demonstration/Tutorial Database or Quit Summit Central by selecting the appropriate option button.  

 

Open the Demonstration/Tutorial Database, will connect you to a ‘demonstration’ database that’s 
already been created by MIE Software with fictional data. You should select this option if this is 
the first time you have launched Summit Central 
 

Create A New Empty Database, will ask you to provide a filename, and a new database with that 
filename will be created. The filename you provide must comply with the Windows filename 
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requirements and must end in “.mmd”. If you want to create the Summit Central database in another 
folder or on a network drive, use the Browse button. If you want to create the Summit Central 
database in the default Summit Central folder (c:\Summit), simply enter the filename you wish to call 
it. 

 

Open an Existing Database, Summit Central will ask you to provide a filename, and this must be the 
name of the Summit Central database you have already created. If the Summit Central database is in 
another directory or on a network drive, use the Browse button to locate the file. If the Summit Central 
database is in the Summit Central directory, just select the filename. 

 

Quit, will close Summit Central. 

 

OK will exit enable the requested action to be completed, i.e. create new or open existing database. 
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Printing Reports 

When you click on the Preview  button or the Listing   button, all reports and listings are 
printed in print preview, i.e., they are printed to the screen. If you want to do more than just look at the 
report on the screen, click on the File menu in the top left hand corner of the screen. 

 

 

If you click on Close, you close the 
report.  

 

If you click on Print Setup..., you can 
change the margins, columns and 
other details of the report. 

 

If you click on Print..., the following 
form is displayed. Within this form you 
can direct the report to any printer, 
print part of the report, print multiple 
copies, alter the print setup, etc. 

 

If you click on the Send... button (if 
enabled) it interfaces to the Mailing 
system on your network, e.g. to 
Microsoft Outlook as a new message. 

 

 

 

 

 

 

 

Additionally you can create a new version of the report in Excel, Rich Text Format, Text or a HTML 
document. 
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Closing Reports 
 

You can exit a report in Summit Central in one of three ways. 

 

 

 

 

 

1. Click on File then the Close or press Alt+F+C 

 

 

 

 
 

 

 

2. Select Close from the system menu icon as 
shown below, however, this will close down 
Summit Central completely. 

 
 

 

3. Press the Esc button on your keyboard. This 
last option is the easiest. 
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Shortcut Keys 

 

Copying 
Ctrl+C Copy the selection onto the Clipboard. 

Ctrl+V Paste the contents of the Clipboard at the insertion point. 

Ctrl+X Cut the selection and copy it onto the Clipboard. 

Ctrl+’ (single 
quote mark) 

Insert the same value as in the same field in the previous record. 

 

Deleting 
 

Backspace Delete the selection or the character to the left of the insertion point. 

Delete Delete the selection or the character to the right of the insertion point. 

 

Undoing 
Changes 

 

Ctrl+Z or 
Alt+Backspace 

Undo typing. 

Esc Undo changes in the current field or current record; if both have been 
changed, press Esc twice to undo changes first in the current field and then in 
the current record. 

 

Text Formatting 
 

Ctrl+U Change current field to UPPER CASE. 

Ctrl+L Change current field to lower case. 

Ctrl+T Change current field to Title Case. 

 

Moving Around 
 

Right Arrow Move one character to the right. 

Ctrl+Right Arrow Move one word to the right. 

End Move to the end of the line. 

Ctrl+End Move to the end of the field in multiple-line fields. 

Left Arrow Move one character to the left.  

Ctrl+Left Arrow Move one word to the left. 

Home Move to the beginning of the line. 

Ctrl+Home Move to the beginning of the field in multiple-line fields. 

Tab, Right Arrow, 
or Enter 

Move to the next field. Enter key moves to the next line in multiple line fields. 

Shift+Tab Move to the previous field. 

F5 Move to the record number box; then type the number of the record you want 
to go to and press Enter. 

Ctrl+Tab Exit the subform and move to the next field in the master form; if not in a 
subform, move to the next field. 
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Combo Boxes 
and List Boxes 

 

Alt+Down Arrow Open/close a combo box or list box. 

Down Arrow Move down one line in a combo box or list box. 

Page Down Move down one set of values in a combo box or list box. 

Up Arrow Move up one line. 

Page Up Move up one set of values. 

Tab To exit the combo box or list box. 

 

Miscellaneous 
 

Ctrl+W Determine Which database you’re currently connected to. 

Ctrl+O Opens the Database Options form. 

Ctrl+R Opens the Organiser form. 

People Form 
 

Alt+C Record a contact with this person. 

Alt+E Open the Event History form for this person. 

Alt+G Open the Groups form for this person. 

Ctrl+G Get the postcode for the current person’s record. (Australia only). 

Alt+H Open the Contact History form for this person. 

Alt+M Open the Membership form for this person. 

Alt+P Open the Profile form for this person. 

Alt+R Open the Personal Information form for this person. 

Alt+S Send this person’s name and address details to a Summit Event Manager 
event file. 

Alt+U Open the User Defined Fields form for this person. 

 

 



Getting Started - 24 

Help 

General Help 
If you click on Help at the top of the screen, a list of options is available as shown below. 

 

 
 

 

• Contents is the table of contents to the help documentation. Click on the area you’d like to 
see. 

• How to Use Help displays the Windows Help facility.  

• Where am I will tell you which database you’re currently working on (the short name, the long 
name and the full file name). This information can be e-mailed directly to MIE Software. 

• About Summit... displays your registration and version number (see below for more 
information) 

• MIE on the Web will display another menu which will direct you to pages of interest on our 
website. 

Displaying on-line help for the current form 
Summit’s on-line help is context sensitive. This means whenever you want help, the help displayed 
relates to the form you’re on. You can display on-line help for the current form in the following ways: 

Press the F1 key on your keyboard. 

Click on the Help button as illustrated.  
 

 

Displaying on-line help for the current report 
You can display on-line help for the currently open report by pressing the F1 key on your keyboard. 
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About Summit  
To display the About the Summit form, select About Summit... from the Help menu. This form displays 
details of the version of Summit Central that is installed and to whom this copy of it is licensed.  

 

If the information in the This product is licensed to: box is “Evaluation Software Only” you’re running 
the evaluation software and there are no restrictions on its use, however there is a limit on the number 
of records you can enter and import. If the information in the This product is licensed to: box is not 
“Evaluation Software Only” and does not display your details you’re probably using the Summit 
Central illegally. If you’re using the software illegally you should be aware that this computer program 
is protected by copyright law and international treaties.  

 

The licence for the Summit Central software can be single or multi-user. If it’s the latter, it’s a group 
licence that allows the software to be loaded on to up to ten computers provided they are on the same 
local area network (LAN) and under the control of the same organisation. The group licence does not 
cover installation in different branches of the same organisation or different organisations on the same 
local area network under the same licence. 

 

If you’re in any doubt as to the legality of your copy of Summit Central, please contact MIE Software 
immediately. 
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Standard Form Design 
All the forms within the setup menu are divided into parameter files (only one record, for example, 
Database Options) and reference files (can have many records, for example, Groups) and all have 
standard toolbar buttons at the bottom of the form. The example below is the Groups reference file 
form. 

 

 
 

 

 

 

Reference Files 
In the reference file forms, the navigation buttons at the bottom of the form indicate how many records 
you have and which record you’re currently on. In the above example you are located on record 1 of 6 
records.  This is also the method you use to move from one record the next. 

 

If you have Microsoft Access 2002 or 2003 installed on your computer you can click into any field in 
the form and sort by that field, i.e. you can sort by the counter, the description or a date.  Click on the 

ascending or descending button  to sort in alphabetical or numerical order or the find button 

 to search specific data within the selected field. 

Combo Box 
The data entered in to the Groups reference file, as shown above, will appear as options in a ‘combo 
box’ in the people form. That is, each Group type entered in the reference file forms a drop down list 
from which to choose. 

 
 

Go to the first record 

Go back one 

Go forward one 
record

Create a new record 

Go to the last record
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To select a group type simply click on the down arrow next to the group and select the relevant 
option.  If the reference file has a counter as the first field it means the counter, or the index to that 
record is stored in the main file, not the text.  This means you can alter the text in the reference file 
and it will be reflected throughout the system immediately.  If there is no counter, then the text itself is 
stored in the file.  In this case if you alter the text in the reference file, it will not be changed in all old 
records that contain that item. 

Toolbar Buttons 
The following are the standard toolbar buttons found on most forms with Summit Central. 

 

 

 

People By clicking on this button you can get a list of people who are included 
within the displayed record, eg, in the particular Group or who attended an event. 

 

 

 Delete deletes the current record. A warning message will first appear asking you 
to confirm deletion of the record and its contents. 

 

 

Listing prints the contents of the underlying reference file to the print preview 
screen. 

 

 
 

Help displays the on-line help appropriate to where you are. 

 

 
 

Cancel cancels any changes made to the record and exits the form 

 
 

Ok saves any changes made to the current record and exits the form. 

 

 

 

 
 

 
 

 

 

Show  Active Only/Show All is a double button which gives the user the option to 
display only reference files that are currently in use (active), or to display all 
reference files in the current form. 
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Entry Menu 
The Entry Menu is the normal entry and exit point for Summit Central.  It is also the point from which 
you can create new, open existing or compact and repair existing Summit Central databases.  

 
 

When you first launch Summit Central the Entry Menu is displayed.  Outlined below are the functions 
of each menu button found here. 

 

 

 

The Setup Menu is the starting point for setting up Summit Central database to 
work effectively for you.  From this menu you define the optional settings for the 
database, interest profiles, user defined fields and reference files used throughout 
the database. See pages 40 to 69 of this manual 

 

 

 

 

The Main Menu is where you enter information about people, contacts and follow 
up tasks and produce reports on the information in your database.  You can also 
use the Main Menu for importing information and to access utility functions. See 
pages 70 to 161 of this manual 

 

 

 

 

The File Menu is used for creating new databases, opening existing databases 
and compacting and repairing databases. See next page. 

 

 

 

 

The Help Menu displays the Summit Central help function useful to new users 
and for clarifying features of the program.  The Help Menu contains a Glossary of 
Terms, a How to Guide of Summit functions and Index of terms to search specific 
help topics. 

 

 

 

Exit closes Summit Central. 
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File 
The File Menu is the point from which you can create new Summit Central databases, open existing 
databases and compact and repair databases.  

 

 
 

• To create a new Summit Central database, click on the New button. 

Summit Central will ask you to provide a filename, and a new database with that filename will be 
created. The filename you provide must comply with the DOS filename requirements and must end 
in “.mmd”. If you want to create the Summit Central database in another directory or on a network 
drive, use the Browse button to find the appropriate drive. If you want to create the Summit Central 
database in the Summit Central Folder (summit), simply enter the filename. 

 

• To open a database that already exists, click on the Open button. 

Summit Central will ask you to provide a filename, and this must be the name of a Summit Central 
database you have already created ([filename].mmd).  

• To compact and repair an existing database, click on the Compact & Repair Data File button. .  

Summit Central will ask you to provide a filename.  This must be the name of an existing database, 
and cannot be in use by you or any other users whilst compacting and repairing. If you want to 
compact and repair the current Summit Central database, you must either open another database 
or create a new database before selecting to compact and repair the file you’re currently in. 

You should compact on a regular basis (i.e. daily or at least weekly), particularly if you have been 
deleting records or performing large imports. Summit Central databases may need repairing if you 
have computer, power or network failures during transactions which update multiple tables and 
indexes. You may suspect a corrupt database if you cannot find a record you know is there or the 
data presented is nonsensical. 


